# TABLE OF CONTENT

## INTRODUCTION
- Installers Access Rights ................................................................. 7
- Hardware/Software Specifications .................................................. 7
- Windows Settings ........................................................................... 7
- Security .......................................................................................... 7
- System Configuration/Installation Type ......................................... 8
- Version Verification ......................................................................... 8
- Migration Tool ................................................................................ 9
- Initial Login/Setup .......................................................................... 9
- Accessibility .................................................................................... 9
- jHAVEN User Roles ........................................................................ 10

## OPENING THE jHAVEN APPLICATION
- Start Menu - All Programs ............................................................. 12
- Desktop ICONs ............................................................................. 12
- Installation Folder .......................................................................... 12

## LOGIN
- Subsequent Logins ....................................................................... 16

## jHAVEN WELCOME SCREEN

## HOME SCREEN DEFAULT
- Home Screen Hyperlinks by User Role ......................................... 17
- Navigating the Home Screen ......................................................... 18

## GENERAL INFORMATION
- Title Bar ....................................................................................... 20
- Menu Bar ....................................................................................... 20
- Tool Bar ....................................................................................... 21
- Data Entry Field Types ............................................................... 21
CLOSE THE ASSESSMENT......................................................................................................................... 51
DELETE AN ASSESSMENT ......................................................................................................................... 52
JHAVEN SEARCH ........................................................................................................................................ 53
    Assessment Search ................................................................................................................................. 53
    Use No Criteria................................................................................................................................. 53
    Use Specific Criteria......................................................................................................................... 54
    Assessment Search for Only One Specific Patient........................................................................ 54
    Clear Search Criteria......................................................................................................................... 54
    Show Hidden....................................................................................................................................... 54
    Sort Search Summary Results......................................................................................................... 55
    Navigating the Search Result Summary.......................................................................................... 55
OPENING AN EXISTING ASSESSMENT ................................................................................................. 55
    Opening a Non-Exported Assessment............................................................................................ 56
    Opening An Exported Assessment.................................................................................................. 57
    Opening an Inactivated Assessment............................................................................................... 58
EDITING/MODIFYING AN ASSESSMENT .......................................................................................... 58
VIEWING AN ASSESSMENT IN VIEW ONLY MODE ................................................................................ 59
EXPORTING ASSESSMENTS FOR SUBMISSION TO ASAP .......................................................... 59
    Action Buttons on the Export Screen............................................................................................ 59
    New Export......................................................................................................................................... 60
    Previous Export............................................................................................................................... 61
IMPORT DATA FROM OUTSIDE SOURCE ......................................................................................... 62
JHAVEN REPORTS ............................................................................................................................... 65
    Report Viewer................................................................................................................................... 65
    Print Report....................................................................................................................................... 66
    Save Report....................................................................................................................................... 66
    Export Report................................................................................................................................... 66
    Available Reports............................................................................................................................ 66
**INTRODUCTION**

The **Outcome Assessment Information Set (OASIS)** was developed by the Centers for Medicare & Medicaid Services (CMS) to set a standardized protocol for assessing the clinical characteristics of Home Health Agency (HHA) patients. This information is used to better support the regulatory process and policy-making by providing survey agencies with a mechanism for objectively measuring Agency performance and quality. It also is used to support a prospective payment system for HHAs. In addition, it provides researchers with a rich set of information to support the development of improved standards of care through the study of patient care outcomes.

The purpose of the OASIS National Automation Project is to provide computerized storage, access, and analysis of the OASIS data on HHA patients across the U.S. The OASIS System consists of several interrelated components, including data communications and an OASIS National Data Repository. It is intended to create a standard, nationwide system for connecting HHAs to their respective state agencies for the purpose of electronic interchange of data, reports, and other information. For additional details please visit the CMS website: [http://www.cms.gov/Medicare/Quality-Initiatives-Patient-Assessment-Instruments/OASIS/Background.html](http://www.cms.gov/Medicare/Quality-Initiatives-Patient-Assessment-Instruments/OASIS/Background.html)

To achieve their goals, CMS has sponsored the development of jHAVEN which replaces the original assessment collection data entry tool HAVEN. jHAVEN is a Java-based application that allows facilities to collect and maintain facility, patient and assessment information for subsequent submission to the appropriate state and/or national data repository. jHAVEN is free software provided by Centers for Medicare and Medicaid Services (CMS).

**INSTALLERS ACCESS RIGHTS**

To install jHAVEN the User must be logged into the PC as a Workstation Administrator. Users of the application MUST have read/write access to the location where the database is installed.

**HARDWARE/SOFTWARE SPECIFICATIONS**

The Minimum and Recommended System Requirements may be found on the QIES Technical Support Office home page: [https://www.qtso.com/index.php](https://www.qtso.com/index.php)

**WINDOWS SETTINGS**

In order to ensure the reliable operation of the jHAVEN software application use of a supported Microsoft Windows operating system is imperative. The Font Size property must be set to “Small Fonts”. This property can be found under the Settings tab of desktop properties: Start\Control Panel\Appearance and Personalization\Display.

**SECURITY**

Making information security one of your organizations core values ensures the prevention of unauthorized viewing of Personally Identifiable Information (PII) or Protected Health Information (PHI).

It is important that providers work with their Information Technology (IT) team or other resources to build a security-minded organizational culture which enforces strong authentication and access controls as well as limits physical access to devices (e.g., laptops, handhelds, desktops, servers, thumb drives, CDs, backups) containing PII or PHI data.
CMS recommends that providers encrypt the hard drive of any electronic device which has access to data containing PII or PHI, such as exported assessment records. Once assessments have been exported from the jHAVEN application the data will no longer be encrypted. It is also recommended that those electronic devices, which contain PII or PHI, be physically secured and locked (password protected) when not in use.

SYSTEM CONFIGURATION/INSTALLATION TYPE

STANDALONE
The Standalone installation is self-contained on one workstation.

NETWORK CLIENT
The Network Client/Server installation uses a server to support one or more individual workstations, all accessing one database by multiple computers and users.

- Servers hold the central database and must utilize the Server installation file first.
- Network Clients are placed on the users individual workstations which then access the database on the Server. The Network Client is installed after the Server installation has been successfully completed.

Please refer to the jHAVEN Installation Guide for assistance installing and setting up the jHAVEN application. The QIES Help Desk is available for technical support and assistance if needed and may be contacted by phone at 877-201-4721 or by email to help@qtso.com.

VERSION VERIFICATION
Information about the version of jHAVEN currently installed may be found by selecting ‘About Quality Management System’ from the Help drop-down on the Menu Bar.

The System Configuration/Installation Type, Feature Label and Feature Version are displayed in the lower left side of the screen.
When the jHAVEN application is accessed and the computer running jHAVEN has an internet connection, the application will compare the version currently installed with the version available on the QIES Technical Support Office (QTSO) website. If a new version of jHAVEN is available, a message will display directing the user to the QTSO website to download the latest version.

**Migration Tool**

The process steps for utilizing the Migration Tool are covered in the jHAVEN Migration Guide.

**Initial Login/Setup**

Please consult the jHAVEN Installation Guide for initial login and setup information.

**Accessibility**

Selecting the ‘Enable Accessibility Features’ checkbox at the bottom of the login screen will turn on accessibility features for users requiring assistive technology (e.g. screen readers).

If the user chooses to use the Accessibility Features, the Accessibility icon will display in the Tool Bar on screens within jHAVEN. The user can either click on the icon or use ALT+J to open the accessibility screens.

By default, the ‘Enable Accessibility Features’ checkbox will be checked the first time the Login pop-up displays. This checkbox being checked indicates accessibility features are turned on. The User may determine whether they wish to use the accessibility features by either checking or unchecking the checkbox. The checkbox will remain checked, or unchecked, until changed by the user when the user logs into the application again.
When Accessibility Features are enabled, the “Welcome to jHAVEN” pop-up window will display each time a user successfully logs into the application.

“This is the Welcome message for jHAVEN. After closing this dialog box, press the ALT key to enable the drop-down menu to perform jHAVEN administration activities and assessment entry. Use CONTROL + Page Up and CONTROL + Page Down to switch between open screens. Press ALT + J to get additional information about that window. Currently, the screen that is open is used to detail the various sections of jHAVEN. It consists of multiple sections, each with a button to take the user to the section described.”

**JHAVEN USER ROLES**

The following User Roles are available within jHAVEN:

- System Administrator
- Data Entry
- View Only

Each User Role has a unique level of access within jHAVEN. The table below provides a summary of the access rights available to each User Role. Access is listed by Menu Options based on which screen is active.
## Table Legend:
- ‘Yes’ indicates that the Menu Item is available AND the Option is in the drop-down, therefore available.
- ‘No’ indicates that the Menu Item is available, BUT the Option is NOT in the drop-down, therefore unavailable.
- Dash (-) indicates that the Menu Item is NOT available to the user and therefore there will not be a drop-down with Options.

## Footnotes:

1. Alt Keys are valid only if that user has access to that function.

2. Under the File Menu item, only those menu options available to that user, will have icon(s) in that user's tool bar. If the option is not available to user, then the icon will not appear in the user's tool bar.

### Exception: 'Save All' and 'Change Backup File Location' are only available in the File Menu; NOT on the Tool Bar.

---

**OPENING THE JHAVEN APPLICATION**

Once jHAVEN has been installed and the ‘initial setup’ has been successfully completed, access the program using one of the following methods.

---

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>HOT Keys</th>
<th>Default User</th>
<th>Sys Adm</th>
<th>Data Entry</th>
<th>View Only</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Alt+F</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Administration</td>
<td>Alt+A</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Import/Export</td>
<td>Alt+I</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Import</td>
<td>Ctrl+I</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Export</td>
<td>Ctrl+E</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Reports</td>
<td>Alt+R</td>
<td>-</td>
<td>Yes</td>
<td>Limited</td>
<td>Limited</td>
<td>Yes</td>
</tr>
<tr>
<td>Security Menu</td>
<td>Alt+U</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Assessment</td>
<td>Alt+M</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Help Menu</td>
<td>Alt+H</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

---

Table Legend:
- ‘Yes’ indicates that the Menu Item is available AND the Option is in the drop-down, therefore available.
- ‘No’ indicates that the Menu Item is available, BUT the Option is NOT in the drop-down, therefore unavailable.
- Dash (-) indicates that the Menu Item is NOT available to the user and therefore there will not be a drop-down with Options.

Footnotes:

1. Alt Keys are valid only if that user has access to that function.

2. Under the File Menu item, only those menu options available to that user, will have icon(s) in that user's tool bar. If the option is not available to user, then the icon will not appear in the user's tool bar.

Exception: 'Save All' and 'Change Backup File Location' are only available in the File Menu; NOT on the Tool Bar.
START MENU - ALL PROGRAMS
Click the jHAVEN folder in the start menu to list the available links:

- jHAVEN User Guide
- jHAVEN
- Uninstall
- www.cms.gov
- www.qtso.com

DESKTOP ICONS
Double click the icon found on the desktop. Please note, only one icon will be on the desktop.

INSTALLATION FOLDER
Navigate to the folder where jHAVEN was installed, double click the jHAVEN.exe file.
The jHAVEN splash screen displays momentarily.

The Welcome to jHAVEN screen displays while the program is loading. This may take a few minutes and requires no response from the user.

The welcome tab on the Welcome screen can be closed by clicking the white ‘X’ that appears after the tab title “Welcome”. This may only be done if the Login pop-up window has not yet been displayed.

Only one instance of jHAVEN may be active/open at a time. If a user attempts to begin a second session of jHAVEN the following error message will display: “Another instance of jHAVEN is currently running.”
**LOGIN**

The title bar of the login screen will include the User Tool acronym (jHAVEN) and software version number. Accessibility can be turned off on this pop-up window by removing the check in the checkbox. If the box remains checked the Accessibility Features will be turned on. Please see [Accessibility](#) for additional details.

Please consult the jHAVEN Installation Guide for details regarding the initial login and setup of jHAVEN.

After completing the initial setup of jHAVEN, complete the following steps to login to jHAVEN for the first time.

1. In the User ID field, enter the User ID, which was assigned by the Default User.
2. Enter this same User ID into the Password field.

NOTE: The User ID and Password are case sensitive.

3. Click Login.

4. The ‘Change Password’ screen displays. Passwords are case-sensitive. The following rules are displayed at the top of the Change Password screen:
   i. “The new password and the confirm new password must match.”
   ii. “The new password must be at least 8 characters long.”
   iii. “The new password must be no more than 20 characters long.”
   iv. “The new password must not contain any space.”
   v. “The new password must not contain the User ID, First Name, Last Name, or Email.”
   vi. “The new password must not begin with a number.”
   vii. “The new password can only contain a maximum of 3 repetitive characters.”
   viii. “The new password must contain at least one for each of the following type of characters.”
   ix. “Upper-case Character: A-Z”
   x. “Lower-case Character: a-z”
   xi. “Number: 0-9”
xii. “Special Character: - &~'!@#$%^*()_+={}\[\]\\|:\';"'<>,.?/”
xiii. “The new password must not match any of the user’s most recent 6 passwords.”
xiv. “The new password will be set to expire in 60 days.”

The new password and the confirm new password must match.
The new password must be at least 8 characters long.
The new password must be no more than 20 characters long.
The new password must not contain any space.
The new password must not contain the User ID, First Name, Last Name, or Email.
The new password must not begin with a number.
The new password can only contain a maximum of 3 repetitive characters.
The new password must contain at least one for each of the following type of characters:  
  Upper-case Character: A-Z  
  Lower-case Character: a-z  
  Number: 0-9  
  Special Character: &~'!@#$%^*()_+={}\[\]\\|:\';"'<>,.?/
The new password must not match any of the user’s most recent 6 passwords.
The new password will be set to expire in 60 days.

5. Enter a new password in the ‘New Password’ and ‘Confirm New Password’ fields. These must be identical.

6. Click the ‘Continue’ button to complete the login process.

Please Note: When Cancel is clicked, then another Change Password pop-up comes up with the following message: “You must change your password before accessing the system. If you do not change the password, you will be logged off the system”. Clicking the ‘Cancel’ button on this pop-up takes the user back to the previous Change Password pop-up. Clicking OK takes the user to the login screen.

7. The Security Questions screen displays. It is required that the user respond to at least six (6) of the ten security questions listed. Once complete the user must tab forward in order to enable the “OK” button.

- “What city were you born in?”
- “What year did you graduate from high school?”
- “What is your favorite sport?”
- “What was the make of your first car?”
- “What was the color of your first car?”
- “What is your mother’s maiden name?”
- “What was the name of your first pet?”
- “What size shoe do you wear?”
- “What is your favorite season of the year?”
• “What is your favorite movie?”

To enable the OK button, a minimum of 6 answers are required.

- What city were you born in?
- What year did you graduate from high school?
- What is your favorite sport?
- What was the make of your first car?
- What was the color of your first car?
- What is your mother's maiden name?
- What was the name of your first pet?
- What size shoe do you wear?
- What is your favorite season of the year?
- What is your favorite movie?

8. Click “OK” to continue.

**SUBSEQUENT LOGINS**

Complete the following steps to login to jHAVEN if this is NOT the first time doing so AND you have set up your password successfully.

1. Enter the User ID assigned by the System Administrator user.

2. Enter the Password you have created into the Password field.

   **Please Note:** The User ID and Password are case sensitive.

3. Click Login.

**JHAVEN WELCOME SCREEN**

The first screen to be displayed is the jHAVEN Welcome Screen (when Accessibility Features are enabled) followed by the Home Screen.

- The System Administrator will have access to the following Menu Bar items: File, Administration,
Import/Export, Reports, Security, Assessment, and Help.

- The Data Entry User will have access to the following Menu Bar items: File, Administration, Reports, Security, Assessment, and Help.
- The View Only User will have access to the following Menu Bar items: File, Reports, Security, Assessment, and Help.

**HOME SCREEN DEFAULT**
The Home Screen is dynamic based on the User’s assigned User Role.

By default jHAVEN will display the Home screen each time the user successfully logs into the application. To turn off the default setting the user may place a checkmark into the checkbox next to the statement “Do not display this home screen after logging into the application.” which is located at the bottom left corner of the Home screen.

If the Home screen is not being displayed, it may be re-displayed using the Help Menu Item or by selecting Ctrl+Alt+W.

**Please Note:** The Home screen default setting is unique to each user, and remains unchanged until the user changes it using the checkbox. This is true even when the software is upgraded; user settings will remain the same.

**HOME SCREEN HYPERLINKS BY USER ROLE**
All the User Roles will initially have access to their respective Home screen. The Home screen will vary by User Role however they are all similar in format.

**System Administrator**

After the System Administrator is successfully logged in, the application Welcome screen will become available with a Menu Bar and a Tool Bar. The System Administrator will have access to the following Menu Bar items and their drop-down options: File, Administration, Imports/Exports, Reports, Security, Assessment, and Help.

The Home screen is displayed with the following “Go To” action buttons: Agency, Branch, User, Patient, Assessment, Import/Export, Reports, Enforcement and User Guide. Below is an example of the System Administrator’s Home screen.
Data Entry User

After the Data Entry User is successfully logged in, the application Welcome screen will become available with a Menu Bar and a Tool Bar. The Data Entry User will have access to the following Menu Bar items and their drop-down options: File, Administration, Reports, Security, Assessment, and Help.

The Home tab is displayed with the following “Go To” action buttons: Agency, Branch, Patient, Assessment, Reports, and jHAVEN User Guide.

View Only User

After the View Only User is successfully logged in, the application Welcome screen will become available with a Menu Bar and a Tool Bar. The View Only User will have access to the following Menu Bar items and their drop-down options: File, Reports, Security, Assessment, and Help.

The Home tab is displayed with the following “Go To” action buttons: Assessment, Reports, and jHAVEN User Guide.

Navigating the Home Screen

The ‘Go To’ action buttons are used to navigate directly to an application screen, pop-up window, or the User Guide. Each button has verbiage to indicate how it is to be used. Examples using the Home screen buttons are shown in the following sub-sections.
Navigating to the Agency Screen

The following flow is illustrated using the ‘Go To Agency’ button. This hyperlink takes the user directly to the Agency screen. Complete the following steps:

1. Log into the application.
2. Click on the ‘Go To Agency’ button.
3. The Agency screen displays.

The Agency screen displays all of the agency data that is currently available. The user may view and/or manipulate the data as their access allows.

4. Close the Agency screen. If the Agency screen is the only screen open, then the Home screen will be displayed. If other Administration screens are open, they will need to be closed for the application to automatically go back to displaying the Home screen.
   a. You may always click on the Home Tab to display the Home screen.

Navigating to a Pop-up Window

The following flow is illustrated using the ‘Go To Assessment by Status’ button under Reports. This hyperlink takes the user directly to the criteria pop-up window required for the Assessment Data Entry – Status Report. Complete the following steps:

1. Log into the application.
2. Click on the ‘Go To Assessment by Status’ button.
3. The Assessment Data Entry – By Status criteria pop-up window displays.
4. Select the Agency, Status (or Statuses), and the Data Entry From and To Dates.
5. Click the ‘OK’ button.
6. The Criteria screen closes and the Report Viewer will display the report.

Navigating to the User Guide

When the ‘Go To User Guide’ button is used, the .pdf copy of the User Guide for jHAVEN is opened and displayed. If the application cannot find the User Guide where it is expected, the following error message displays: “Unable to locate the user guide. Please contact your system administrator.”

1. Click the ‘OK’ button.
2. Contact your System Administrator.

GENERAL INFORMATION

TITLE BAR
The Title Bar displays the name of the software, jHAVEN, and the software version.

MENU BAR
The Menu Bar includes drop-down lists which contain command selections based on user roles and the open screens. Utilizing the ‘Alt’ key on the keyboard will place the cursor in the menu bar. Use the arrow keys on the keyboard to navigate through the selections on the menu bar.
TOOL BAR
Each screen contains a Tool Bar that displays various buttons and icons to assist the user. Holding the mouse over the icons will display the name of the functionality. The availability of the icons will vary depending upon the user role and the Administration screen displayed (active).

DATA ENTRY FIELD TYPES

TEXT
Text fields allow data to be entered manually, which adheres to the submission rules (length, alpha, numeric, special characters, etc.) for each specific field. These fields may be required or optional. If a text field is a required field and nothing is entered into it, and the user tabs past it, a warning message will be displayed.

The following are examples of text fields taken from the patient screen: Patient First Name, Patient Middle Initial, Patient Last Name, and Patient Suffix.

DATE
Date fields are formatted for the entry of a valid date. The date may be entered manually or, if accessibility is turned OFF, by clicking on the calendar next to the date field and selecting a date.

The valid format of all dates will be MM-DD-YYYY.

- Where: MM= Month = 01-12, DD= Day = 01-29, 30, or 31, depending on the month, and YYYY equals the four digit year.

The following is an example of a date field.

CHECKBOX
Checkboxes allow the selection of values associated with each box. If the checkbox is checked the value will be included. If the checkbox is not checked, it will not be included. The following is an example of this type of checkbox.
CHECKBOX USED WITH OTHER DATA FIELDS
There are data fields of various types that must have required input. However, at the time the assessment is performed all of this information may not be known. Therefore, a checkbox is provided to indicate that the user has not skipped this item, but, in fact, does not have the information. Thus, ‘required’ data has been provided.

Later in the verification process this may result in an error, which the user must correct by actually supplying the requested data. In the example below Checkboxes are used in conjunction with Text fields.

- The Medicare Number is unknown, the checkbox is checked.
- The Social Security Number is also unknown or unavailable, the checkbox is checked.
- The Medicaid Number is known and was entered; therefore the checkbox below the item is disabled.

DROP-DOWN LIST
Drop-down lists contain allowable answers for a specific field. To answer a drop-down question, tab to the field and use the arrow keys on the keyboard to navigate through the answer options. Once the appropriate answer is displayed, use the Tab key to move to the next question. A mouse may also be used to select an answer in a drop-down list. Click the arrow on the right side of the field to expand the list. Click the desired answer. Click the mouse on the next question or use tab to continue. The Delete key on the keyboard can be used to clear the field. The following is an example of a drop-down list.
**List Box**
A List Box is a display-only box that the application populates. The first row will contain the field name, plus the field’s M00#, if it exists. The remaining row(s) will be populated with data selected by the User. List Boxes are most often associated with Grid fields.

**Grid**
Grid buttons are used for selection of one or more values and typically including a large number of selection options. Click on the grid button for a series of pop-up windows containing lists of items from which to choose. The Grid opens up to an empty selection list. For example, use the ‘New’ icon to display a pop-up list of the available diagnosis codes. The User may also enter a data into the ‘Select a Value’ field and to do a simple search of this list. Make selections as appropriate then close the pop-up list. The jHAVEN application will pull the user’s selection(s) into the List Box, which is a display-only field. This box will be expanded to accommodate multiple selections. If the user wishes to modify this selection, they must return to the Grid button and repeat the process.
**EDITS**
Data edits are applied to the fields during the data entry process into jHAVEN.

**Please Note:** These edits are unique messages to assist users with the accurate completion of data entry. Some will present a pop-up message and must be addressed at the time they are displayed in order to proceed. Other edits may not appear until the entry is saved & validated. The error messages shown are assigned numbers to aid in troubleshooting. When there are questions about a message, it is beneficial to record the message before calling the Help Desk. This can facilitate quicker answers and/or resolutions.

**ERROR MESSAGES**
This type of edit message lets the user know information entered is incorrect or missing. It must be corrected or entered before the information will be saved. This is referred to as a “fatal” error. The ‘X” symbol identifies this message as a fatal error message.

![Error Message Example](image)

**WARNING MESSAGES**
This type of message indicates there is information entered that should be verified as accurate, or serve as a reminder of how some fields should be populated. The ‘!” symbol identifies this message as a Warning Message.

![Warning Message Example](image)

**DECISION MESSAGES**
This type of message requires a decision on the part of the User. This message may also include additional information to aid the User in their decision. The decision will most often directly affect the process. The ‘?” symbol identifies this message as a Decision Message.

![Decision Message Example](image)
INFORMATIONAL MESSAGES
This type of message indicates that something has, or may occur. These messages provide additional information about the field or the process. The ‘I’ symbol identifies this message as an Informational Message.

ENFORCEMENT
Enforcement of Assessment Sequencing is turned on during installation, as a system default. The System Administrator is the only user who may turn this feature off once the installation and application “start-up” process has occurred. Assessment Enforcement sequencing rules are used only in conjunction with adding assessments.

TYPES OF SEQUENCING
There are two (2) types of sequencing: 1) Strong Enforcement and 2) Weak Enforcement.

STRONG ENFORCEMENT
Strong enforcement of assessment sequencing is automatically set when the software is installed. This type of sequencing provides an error whenever a newly added assessment violates the sequencing rules. It prohibits that specific type of assessment from being added.

WEAK SEQUENCING
Weak enforcement of the assessment sequencing may be set by the System Administrator after the completion of installation of the software. This type of enforcement provides a warning, which indicates that sequencing is being violated. However, it does NOT prohibit the assessments type from being added.

The following steps should be completed to reset the Enforcement switch after installation:

1. Select the Enforcement option from the Assessment drop-down on the Menu Bar.
2. Uncheck the checkbox in front of “Enable Strong Enforcement” to switch over to ‘Weak Enforcement’.

![Enforcement window](image)

3. Click ‘Save’.

**RFA RECORD SEQUENCING RULES**
The sequence of records for a patient must conform to certain requirements. For example, a resumption of care record cannot directly follow a start of care assessment record. The following table indicates allowable sequences of records. In this table, the abbreviation *RFA* is used to represent the “Reason For Assessment” contained in item M0100_ASSMT_REASON. X’s in the table are used to indicate allowable record sequences.

To understand this table, consider a sequence of records for a particular patient served by a particular home health agency and assume that the records are ordered by effective date as defined above. Let’s suppose a particular record in the sequence is designated *Record A*. If *Record A* is immediately followed by a second record in the sequence (called *Record B*), the table below can be used to determine what RFAs are allowed for *Record B*.

For example, suppose *Record A* has an RFA of 03 (resumption of care after inpatient stay). We can see from the row labeled “03” that there are check marks under RFAs 04 through 09. This means that if a record with an RFA equal to 03 occurs in the record sequence and if it is immediately followed by another record, that record must have an RFA equal to 04, 05, 06, 07, 08, or 09.
In general, the initial record in a sequence of records will have an RFA of 01 (start of care – further visits planned). However, there can be exceptions to this general rule. One example involves patients who turn 18 while under care. For these patients, the HHA is not required to do a start of care assessment, but must instead submit data for the next required comprehensive assessment. Another example occurred when the OASIS electronic submission system was first put in place. Home health agencies were required to submit assessment data for all patients who were currently under care, but the rule requiring an RFA 01 for an initial record was waived for patients who were currently under care on the startup date.

**MASTER DATA (ADMINISTRATION SCREENS)**

Before any assessments can be created, a basic set of Master Data is required. This data consists of Agency data, User data, Branch data and Patient data which are entered into jHAVEN via the Administration Screens. Tabs for any open Administration screens will display under the Tool Bar. An asterisk (*) next to the name on the tab means there are changes that need to be saved.

The various Administration screens are divided into multiple sections. Sections displayed are dependent upon the type of screen.

The Agency screen is divided into:

- Summary
- Detail
- Agent Information

The User screen is divided into:

- Summary
- Detail
• Activation
• Agency

The Branch screen is divided into:

• Search Criteria
• Summary
• Detail
• Contact Person
• Actions

The Patient screen is divided into:

• Search Criteria
• Summary
• Detail
• Actions

Each section can be collapsed by use of the arrow to the left of the section title. Clicking on the arrow a second time will expand the section.

Some sections may also be resized if needed by placing the cursor over the line that separates the sections. The cursor will create an arrow. Click and drag the line to either the right or left depending on which area the user wants to expand. Columns in the Summary section can be resized by clicking and dragging on the line between headings.

**AGENCY SCREEN – ADD & MAINTAIN AN AGENCY**

**CREATE AN AGENCY**

For optimization of the skip patterns and/or edits, it is recommended that data be entered in the order the questions appear on the screen. Entering data out of order can cause unexpected results.

The Agency screen allows users, to setup, modify and delete agencies. The term “Agency” refers to a Home Health Agency.

Complete the following steps to create a new Agency.

1. Select the Agency option from the Administration drop-down on the Menu Bar.
2. Click the ‘New Agency’ icon on the Tool Bar or Ctrl+N.

3. Enter agency detail information into the appropriate fields. Required fields display on the screen in bold type with an asterisk (*).
4. Click the ‘Save’ icon.
   a. If Accessibility is on, the ‘Save Agency’ options pop-up window displays.
      i. Selecting Save and Close will save the updated information and close the Agency screen completely.
      ii. Selecting Save and Continue will save the updated information and return to the Agency screen.
      iii. Selecting Cancel will void any updated and return to the Agency screen.

![Save Agency Options Pop-up Window]

5. An informational message displays to confirm that the agency has been saved.

![Agency Saved Message]

6. Saved agency information will display in the Agency Summary section on the left side of the screen.

![Agency Summary Section]

Please Note: Edits are performed during the data entry process which may result in Warnings, Errors or other Informational pop-up messages through the process of adding an Agency. If errors remain at the time the Agency is saved, the errors are summarized in a pop-up window.
MODIFY AN AGENCY
Complete the following steps to modify an existing agency.

1. Locate and highlight the agency in the Agency Summary section.

2. Make the appropriate changes on the right side of the screen in the Agency Detail section.

3. Click the ‘Save’ icon.

EFFECTS OF MODIFYING THE AGENCY ID FIELD
The User may modify the Agency ID in an existing Agency. When this is done through the Agency screen, the following activities occur within ALL Administration Screens.

- Any User that has been associated with the original Agency ID will be re-associated with the NEW Agency ID.
- If there are Branches associated with the original Agency ID, the Branch will be re-associated with the NEW Agency ID.
- If there are patients associated with the original Agency ID, those Patients will be re-associated with the NEW Agency ID.
- If there are assessments associated with any patient that has been re-associated with an updated Agency ID, when these assessments are re-opened, a Decision Message will be displayed stating “The agency information has changed. Would you like to update the assessment to reflect these changes?”

DELETE AN AGENCY
Complete the following steps to delete an agency.

1. Locate and highlight the agency in the Agency Summary section.

2. Click the ‘Delete’ icon on the Tool Bar.
RULES:

- An Agency cannot be deleted if patients have already been created under that agency.
- An Agency with no CCN will be rejected by the ASAP system.
- A Branch is a satellite of an Agency. Any branch must be tied to an agency.

USER SCREEN – ADD & MAINTAIN A USER

CREATE A USER

For optimization of the skip patterns and/or edits, it is recommended that data be entered in the order the questions appear on the screen. Entering data out of order can cause unexpected results.

The User screen allows users, based on User Roles, to setup new users, modify users and delete users. There must always be at least one active System Administrator. It is highly recommended that there be at least two System Administrators.

Complete the following steps to add a new user.

1. Select the User option from the Administration drop-down on the Menu Bar.

2. The User screen displays.

3. Click the ‘New User’ icon on the Tool Bar or Ctrl+N.
4. Enter user information into the User Detail section. Required fields display on the screen in bold type with an asterisk.

5. Enter the Agency Detail. The user must select an Agency to which this User will be associated.

6. Branch information is not required. However, the user will get a warning message if no branch association is selected. The following Branch Options are available:
• [N] = The agency selected has no branches at this time.
• [P] = Parent Agency. This user is not associated with a specific Branch, but is associated with the agency (the parent) that was selected.
• 10-character Branch ID

Please Note: The 10-character Branch ID will only be listed under ‘Branch’ if the System Administrator has already entered that Branch into the jHAVEN database.

7. Click the ‘Save’ icon.

8. Saved user information will display in the User Summary section on the left side of the screen.

MODIFY A USER
Complete the following steps to modify an existing user.

1. Select the User option from the Administration drop-down on the Tool Bar.

2. The User screen displays.

3. Locate and highlight the user in the User Summary section.

4. Make the appropriate changes under the User Detail panel, on the right side of the screen.
   Please Note: The User ID field cannot be modified once the user is saved.

5. Click the ‘Save’ icon.
DELETE A USER
Complete the following steps to delete a user:

1. Locate and highlight the user in the summary section.
2. Click the ‘Delete’ icon.

TERMINATION DATE
A Termination Date may be used in lieu of deleting a User and should only be entered if an active user is no longer valid (e.g., no longer works for the agency). If a Termination Date is entered, a Termination Date message box displays advising pending assessments should be reassigned to an active user.

BRANCH SCREEN – ADD & MAINTAIN A BRANCH
The Branch screen allows users, to add, edit, delete and search for Branches. Branches may be added to the jHAVEN application after the Branch ID has been assigned by the CMS State Agency and provided to the Agency. Only System Administrators may add Branch records.

CREATE A BRANCH
Complete the following steps to add a new Branch:

1. Select the Branch option from the Administration drop-down on the Menu Bar.

2. The Branch Information screen displays.
3. Enter Branch information into the appropriate fields within the Branch Detail section. Required fields display on the screen in bold type with an asterisk (*).
4. Click the ‘Save’ icon in the Tool Bar.

5. Saved Branch information will display in the Branch Summary section.

6. To add additional Branches Click the ‘New Branch’ icon on the Tool Bar or Ctrl+N. Enter data and click the ‘Save’ icon OR click the ‘Add Branch’ button at the bottom of the Branch screen.

**MODIFY A BRANCH**

Complete the following steps to modify an existing Branch:

1. Locate and highlight the Branch in the Branch Summary section.
2. Make the appropriate changes on the right side of the screen.
3. Click the ‘Save’ icon.

**EFFECTS OF MODIFYING THE BRANCH ID AND/OR BRANCH STATE**

The User may modify the Branch ID and/or the Branch State in an existing Branch. When this is done through the Branch screen, the following activities occur within ALL Administration Screens and Assessments.

- Any Agency that has been associated with the original Branch ID will be re-associated with the NEW Branch ID and NEW Branch State, if modified.
- Any User that has been associated with the original Branch ID will be re-associated with the NEW Branch ID and NEW Branch State, if modified.
- Any NON-Exported assessment associated with the original Branch will be automatically updated with the NEW Branch data at the time this data was saved.

**DELETE A BRANCH**

Only System Administrators may delete Branch records. A Branch cannot be deleted if it has been associated with a User. A Branch cannot be deleted if one or more assessments have been created using that branch.
Complete the following steps to delete a Branch:

1. Locate and highlight the Branch in the Branch Summary section.

2. Click the ‘Delete’ icon OR click the ‘Delete Branch’ button at the bottom of the screen.

**PATIENT SCREEN – ADD & MAINTAIN A PATIENT**

Patients may be added to the jHAVEN application by System Administrators and Data Entry Users. The Patient screen allows users, to add, edit, delete and search for Patients.

**CREATE a PATIENT**

Complete the following steps to add a new Patient:

1. Select the Patient option from the Administration drop-down on the Menu Bar.

![Administration Menu with Patient Option Selected]

2. The Patient screen displays.

![Patient Screen]

3. Enter Patient information into the appropriate fields within the Patient Detail section. Required fields display on the screen in bold type with an asterisk (*).
4. Click the ‘Save’ icon or the ‘Add Patient’ button to save the Patient.

5. Patient information will be displayed in the Patient Summary section.

![Patient Summary](image)

6. To add additional Patients click the ‘New Patient’ icon or the ‘Add Patient’ button. Enter data and click the ‘Save’ icon.

**MODIFY A PATIENT**

Complete the following steps to modify an existing Patient:

1. Select the Patient option from the Administration drop-down on the Menu Bar.

![Menu Bar](image)

2. The Patient screen displays.

3. Locate and highlight the Patient in the summary section.

4. Make the appropriate changes within the Patient Detail section on the right side of the screen.

5. Click the ‘Save’ icon.

**EFFECTS OF MODIFYING PATIENT DATA**

When Patient data is modified, the changes will be shown within the summary section of the Patient and Assessment Administration screens. When assessments are re-opened after updating Patient Details, a Decision Message will be displayed stating: “The patient information has changed, would you like to update the assessment to reflect these changes?” The User must determine whether to allow existing assessments to be updated with new patient data.
MOVE A PATIENT FROM ONE AGENCY TO ANOTHER AGENCY

A patient is assigned to an agency via the Patient Information screen. To move a Patient from one Agency to another, all the existing assessments, created under the existing Agency, must be exported.

First review this patient’s assessments and export any assessments that have NOT been exported. See Exporting Assessments for Submission into ASAP.

If there are non-exported assessments for the patient and the user wishes to move that patient, the following error message will display: “Non-exported assessment currently exist for this patient for agency (Agency Name). All existing assessments must be exported before changing the agency ID. Please export all existing assessments for this patient and again change the agency ID on the Patient Information screen.”

Complete the following steps to move a patient from one agency to another:

1. Select the Patient option from the Administration drop-down on the Menu Bar.
2. The Patient screen displays.
3. Locate and highlight the Patient in the summary section.
4. Make the appropriate changes within the Patient Detail section on the right side of the screen.
5. Click the ‘Save’ icon.
6. The ‘Confirm Change Agency’ screen is displayed requesting confirmation that you would like to complete the patient move process. A listing of all assessments which will remain associated with the original agency will also be provided.
7. Click ‘Finish’ to continue.

8. The ‘Confirming Patient Move’ informational message will be displayed.

9. Review the Patient Summary.
   a. Look for the patient that was moved. Because this patient had exported assessments, there will be:
      i. One row associated with the original Agency ID with the exported assessments and
      ii. A second row associated with the new Agency ID and no assessments.

Please Note: If the Patient to be moved has NO ASSESSMENTS, then there will only be one (1) row in the Patient Summary.
DELETE A PATIENT
Complete the following steps to delete a patient:

1. Locate and highlight the Patient in the Patient Summary section.
2. Click the ‘Delete’ icon OR click the ‘Delete Patient’ button at the bottom of the page.

Please Note: A patient cannot be deleted if one or more assessments have been created for the patient. If the Patient has an assessment, and the user tries to delete that patient, an informational message along with a listing of existing assessments will be provided stating: “You cannot delete the patient (Patient Name) because they have the following assessment(s).”

LOCATE ASSESSMENTS FROM THE PATIENT SCREEN
If a System Administrator or a Data Entry User needs to see all of the Assessments associated with a specific Patient, they may do so using the ‘View Assessments’ feature. Complete the following steps to see a list of all assessments for a specific patient.

1. Select the Patient option from the Administration drop-down on the Menu Bar.

2. The Patient screen displays.
3. Complete a Patient Search to locate the Patient.

4. Locate and highlight the Patient in the Patient Summary section.

5. Scroll to the bottom of the Patient Detail section located on the right side of the Patient Information screen.

6. Click the ‘View Assessments’ button.

CREATE AN ASSESSMENT
To create an assessment the following must already be accomplished or available:

- Successful Login
- Existing Administration Data: Agency, User, and Patient

Complete the following steps to create an assessment:

1. Select the Patient option from the Administration drop-down on the Menu Bar.

2. The Patient Screen displays.

3. Complete a Patient search or add a new Patient.

4. Locate and double click on the Patient in the Patient Summary section OR scroll to the bottom of the Patient Detail section on the right to utilize the ‘Add Assessment’ button.

5. The ‘Add Assessment’ wizard will launch. The Add Assessment Wizard is a pop-up window used for creating all assessments.

6. Select the OASIS Specification time period based on the anticipated Assessment Completion Date (M0090). Please note, if the incorrect time period is selected, the assessment will need to be deleted and re-keyed.

   a. 10/01/2015 – Ongoing
   b. 01/01/2015 - 09/30/2015
   c. 01/01/2010 – 12/31/2014
7. Select the type of assessment.

8. Click ‘Finish’ to continue to the Assessment screen.

Please Note: After clicking Finish, errors and/or warning messages, if applicable, will display in a pop-up window.

THE ASSESSMENT SCREEN

When the Assessment screen is active, no other screen may be accessed. If a user tries to view one of the Administration screens while an assessment is actively open an error message will be displayed stating: “(Screen Name) cannot be access while an assessment is being edited.” Click ‘OK’ to close the error message and return to the Assessment screen.

When the assessment is first opened after the ‘Add Assessment Wizard’ is completed, there are various data fields, which pull their data from the Administration Screens. These are pre-populated and may not be changed within the assessment.

The Payment Source (M0150) data will be populated from the Patient Screen when the assessment is created. The Payment Source (M0150) may be changed within the assessment itself. This allows the user to set the payment source for a patient specifically for each assessment regardless of how it is set on the Patient screen.

The Branch ID data field (M0016) may also be changed within the assessment using the drop-down options provided. The Branch State is automatically pulled from the Administration Branch Screen for the specific Branch ID selected.
User Tip: For optimization of the skip patterns and/or edits, it is recommended that assessment data be entered in the order the questions appear on the screen. Entering data out of order can cause unexpected results. Enter data in each field and use the “Tab” key on the keyboard to navigate from field to field. This allows skip patterns and edits to be appropriately applied and helps ensure all fields are addressed.

Assessment Details – Screen Sections
The Assessment tab, located under the Tool Bar at the top of the screen displays the assessment type and patient name.

Navigator
The Navigator is on the left side of the Assessment screen. The navigator is a collapsible “tree”, which lists all assessment categories and assessment questions. The fields for the questions that require answers are shown in bold. As questions are answered, they are removed from the tree. To change the setting, utilize the ‘Show/Hide Answered Questions’ icon in the Tool Bar at the top of the screen to continue showing all assessment categories and questions.
ASSESSMENT DATA TABS
There are four (4) tabs directly associated with the Assessment located on the top right side of the assessment screen.

- Assessment
- Patient Details
- Agency Details
- Assessment Determination
ASSESSMENT TAB
This Assessment tab is used for the actual assessment questions and answers. This is where data entry is accomplished.

PATIENT DETAILS TAB
Patient data is displayed on the Patient Details tab in a view only, non-editable, format.
**AGENCY DETAILS TAB**
Agency data is displayed in a view only, non-editable, format.

![Agency Details Table](image)

**ASSESSMENT DETERMINATION TAB**
The Assessment Determination Tab displays the OASIS Specification time period chosen for the active assessment as well as the assessment type.

![Assessment Determination Table](image)

**EDITS**
The Edit section is located on the bottom left corner of the Assessment screen. The errors and warnings found after selecting ‘Save and Validate’ will display in this area. Clicking on an edit message will move the cursor within the assessment to the appropriate field.

![Edit Section](image)

**Please Note:** There are some errors which present a pop up message during the data entry process. These errors must be addressed at the time they are displayed in order to proceed. These edits will not be displayed in the edits listing.
**ASSESSMENT DATA ENTRY**

Data Entry may be completed all in one sitting, or spread out across several sessions.

Complete the following steps to for data entry into the Assessment:

1. Enter applicable data into the assessment beginning at the top of the Assessment tab. Required fields are show in bold in the Navigator section at the upper left corner of the screen.

**Please Note:** Pop-up edit messages must be addressed as they are displayed before continuing on with the data entry. These edits will not display in the Edits listing in the lower left portion of the screen.

2. Click the ‘Save’ icon to save data entry progress as you go.

3. Click the ‘Save and Validate’ icon when data entry is complete.

4. Edit Messages, Errors and Warnings will be shown in the Edits section after selecting ‘Save and Validate’.

**Please Note:** For the system to calculate HIPPS values for the assessment, there are specific data fields that must be completed.

- Error edits must be corrected before the assessment can be exported.
- Warning edits provide only a warning. It is up to the user to enter the data appropriately. Warning edits will not stop the assessment to be exported.

**SAVE**

When ‘Save’ is selected for an assessment, the data is simply saved. It is NOT validated. The status of the Assessment will be set to “IN USE”. Once the data has been saved, the user may then close the assessment. The assessment may be re-opened at a later time for more data entry or for the ‘Save & Validate’ process.
**SAVE & VALIDATE**
The following process occurs when ‘Save & Validate’ icon is selected.

1. The appropriate Data Specification, selected when assessment was created, is loaded.

2. The data is verified and validated using the jHAVEN VUT.

3. If there are no errors, the assessment will be saved and become ‘EXPORT_READY’.

4. If errors and/or warnings are found, they will be identified and provided in the ‘Edits’ list, the assessment will be saved and placed in a “DATA_ENTRY” status.

**ASSESSMENT ERROR REPORT**
All edits found during the ‘Save and Validate’ process may be printed on the Assessment Error Report. To print the Assessment Error Report click the ‘Print Error Report’ button in the Edits section OR click the ‘Print Assessment Error Report’ icon on the Tool Bar.

2. The Report Viewer displays the report.

CLOSE THE ASSESSMENT

User Tip: Before saving and closing an assessment always tab forward off the last field entered. This will ensure that that last field is saved. Assessments may be closed by clicking the white ‘X’ on the corner of the Assessment Tab OR by selecting the ‘Close Assessment’ option under the File Menu.
DELETE AN ASSESSMENT

Only a user with a System Administrator role may delete an assessment. Assessments with a status of EXPORTED cannot be deleted.

Complete the following steps to delete an assessment.

1. Search for the desired assessment using the jHAVEN Search.
2. Click once on the desired assessment.
3. Click the Delete Assessment button at the bottom of the Assessment Search screen.
4. The ‘Confirm Assessment Delete’ message displays “Are you sure you want to delete assessment (Patient’s Name, Birth Date)?”
5. Click ‘OK’ to delete the assessment OR click Cancel to close the message and not delete the assessment.
**jHAVEN SEARCH**

All search features function in the same manner for each screen with the search criteria always being located at the top. The search feature is available within the following screens:

- Assessment Screen
- Branch Screen
- Patient Screen

**ASSESSMENT SEARCH**

Complete the steps below for Assessment Search:

1. Select the Search option from the Assessment drop-down on the Menu Bar and the Assessment Search Screen displays.

![Assessment Search Screen](image)

2. The Assessment Search screen displays.

![Assessment Search Example](image)

**USE NO CRITERIA**

1. If no criteria are to be used, move past the Search Criteria rows, and click the ‘Search’ button.
2. All records found in the database will be returned. The exception would be any Patient or Assessment associated with a Patient marked as “Yes, Hide Patient”. These will not be included in the search results.
   a. You can include them when entering criteria: Check the ‘Show Hidden’ Checkbox.
**USE SPECIFIC CRITERIA**

1. Enter specific criteria to narrow the search, add it into the Search Criteria rows using Field Name, Condition, and Field Value:
   
   a. Text Fields:
      • Fields requiring the User to enter data into the Field Value.
      • Conditions for Text fields will be: Contains, Equal To, and Not Equal To.
   
   b. Fix Value Fields:
      • Fields requiring the User to select an option for a drop-down for the Field Value.
      • Conditions for Fixed Value fields will be: Equal To and Not Equal To.
   
   c. Date Fields:
      • Fields requiring the User to enter a date into the Field Value. Conditions for Date fields will be: Equal to, Greater Than, Greater Or Equal To, Less Than, Less Or Equal To, and Not Equal To.

2. Click the ‘Search’ button.

**Please Note:** When entering search criteria the results shown will only be those that match ALL of the search criteria.

- If one of the criteria fields is used, all three (3) must be used.
- Text fields and date fields will require the user to enter data into the Field Value.
- Fixed value fields will require the user to select a value from a drop-down list.

**ASSESSMENT SEARCH FOR ONLY ONE SPECIFIC PATIENT**

Often it is faster and more efficient to find all the assessments for one single patient. This can be done directly from the Patient Screen using the ‘View Assessments’ button located at the bottom of the Patient Detail section.

**CLEAR SEARCH CRITERIA**

Click the ‘Clear’ button to remove all search criteria.

**SHOW HIDDEN**

Selecting the checkbox next to Show Hidden will include assessments for Patients marked ‘Yes, Hide Record’ on the Patient screen. Unchecking this box will eliminate all Patients that have been hidden from search results.

**Please Note:** The Branch Screen does not contain the “Show Hidden” Checkbox as this is not applicable to Branch Data.
SORT SEARCH SUMMARY RESULTS
The results of the search, whether or not criteria were used will display all results found. The User may re-sort the summary results by clicking on the column headers to change the order in which records are displayed. In the following example, the summary has been sorted by the ‘State’ column.

Navigating the Search Result Summary
Navigating the summary is done using the arrow buttons which are located at the top of the screen. Below is an example of the Assessment Search screen.

The following options are included:

- Begin with first 100 rows of data.
- Go back one page.
- Number of records returned and which are currently displayed in the summary.
- Go forward one page.
- Go down to the last group of 100 rows in this result.
- View All

OPENING AN EXISTING ASSESSMENT
There are different procedures to follow when opening assessments which are dependent on the various assessment ‘Statuses’. Once the desired Assessment is listed in the Assessment Search Summary, highlight it and double click to open it. Based on the Status of this assessment, follow the steps indicated in the following sections.
OPENING A NON-EXPORTED ASSESSMENT
Assessments in the following statuses may be opened and edited as many times as necessary before being exported.

- NEW
- IN_USE
- DATA_ENTRY
- EXPORT_READY
- COMPLETE

Complete the following steps to edit an existing assessment.

1. Search for the desired assessment (Use the jHAVEN Search section).
2. Double click on the desired assessment or click once on the desired assessment and click the Edit Assessment button at the bottom of the page.
3. The Assessment screen opens for editing.
4. Edit the assessment if applicable.
5. If changes are made, click the Save and Validate icon on the Tool Bar.
6. Close the assessment.

Administration Screen Data Has Changed
When the Administration Data is modified (Agency or Patient) AND it is associated with an assessment, it will not be reflected in that assessment at the time the data was actually modified using the Administration Screen. Only when the assessment is opened, by a user with access to update an assessment, will the user be asked if they wish to have that assessment updated with the new data. If the user says, “yes”, then the application will pull the administration data into the assessment. Please note, the User will continue to get this Decision Message until the user answers it with the “Yes” option.

The patient information has changed, would you like to update the assessment to reflect these changes?

Middle Initial: ‘M’ has been changed to ‘Q’

Yes  No  Cancel
OPENING AN EXPORTED ASSESSMENT
Only a user with a System Administrator role may edit an assessment that has been exported.

Complete the following steps to edit an existing assessment with a status of EXPORTED.

1. Search for the desired assessment.

2. Double click on the desired assessment or click once on the desired assessment and click the Edit Assessment button at the bottom of the page.

3. The Exported Assessment message box displays with the following options:
   a. ‘Open this assessment in read only mode’
      i. Assessment opens and displays all previously selected answers from the assessment in a view only, non-editable format.
   b. ‘Create a correction record’
      i. The Correction Number is incremented by ‘1’.
      ii. Assessment opens and displays all previously selected answers from this assessment.
   c. ‘Create an inactivation record’
      i. The Inactivation Assessment opens. All fields are a view only, non-editable format. Once saved, the Reason For Assessment (RFA) Type will be changed to XX-Inactivation.
   d. ‘Reset Status and Edit’
      i. The Assessment opens and displays all previously selected answers in an editable format.
      ii. The Correction Number is NOT incremented.

User Tip: Use the Help button to review the options as they were originally in Classic HAVEN.

4. Select one of the four options provided.
5. Click ‘OK’ to open the assessment.
6. Edit the assessment if required.
7. If changes are made, click the Save and Validate icon on the Tool Bar.
8. Close the assessment.
OPENING AN INACTIVATED ASSESSMENT

Complete the following steps to edit or copy an inactivated assessment:

1. Search for the desired assessment (Use the jHAVEN Search section).
2. Double click on the desired assessment or click once on the desired assessment and click the Edit Assessment button at the bottom of the page.

3. The Exported Assessment message box displays with the following options:
   a. ‘Open this assessment in read only mode’
      i. Inactivation Assessment opens and displays fields in a view only, non-editable format. This selection checks the View Only checkbox at the bottom of the Assessment Search screen. All other assessments will be view only until this box is unchecked.
   b. ‘Create a copy record’
      i. A new Assessment opens and displays all previously selected answers from the most current inactivated record. If a copy has already been made from this inactivation assessment, this option will NOT be available.
   c. ‘Reset Status’
      i. The status of the assessment is also reset to EXPORT_READY, if assessment was Saved and Validated and is without errors.
         OR
      ii. The status of the assessment is also reset to IN_USE, if assessment was closed without saving.

User Tip: Use the Help button to review the options as they were originally in Classic HAVEN.

4. Select one of the three options provided.
5. Click ‘OK’ to open the assessment.
6. Edit the assessment if required.
7. If changes are made, click the Save and Validate icon on the Tool Bar.
8. Close the assessment.

EDITING/MODIFYING AN ASSESSMENT

1. Locate desired assessment using the jHAVEN Search.
2. Add/Modify assessment data using same methods used when adding a new Assessment.
3. Click the Save and Validate icon on the Tool Bar.
4. Close the assessment.
a. Click the ‘X’ on the assessment tab.
   OR
b. Click the Close Assessment option under the File Menu.

**VIEWING AN ASSESSMENT IN VIEW ONLY MODE**
Complete the following steps to open an assessment in view only mode.

1. Search for the desired assessment using the jHAVEN Search.
2. Check the View Only checkbox at the bottom of the screen.
3. Double click on the desired assessment or select the desired assessment and click the View Assessment button at the bottom of the screen.
4. The Assessment screen opens in view only mode.
5. An assessment in view only mode cannot be modified. If this assessment is closed and the user tries to open another assessment from the Search screen, it will be displayed as view only also. The user will need to uncheck the View Only checkbox before opening the assessment to make changes to it.

**EXPORTING ASSESSMENTS FOR SUBMISSION TO ASAP**

**EXPORT RECOMMENDATION:** The application is now encrypted. The encryption within the application is federally required. You may experience some slowness while using export feature. It is strongly recommended to export assessments in small batches and should be done frequently to optimize the application at its best capacity.

The Export Assessments screen allows the user to determine what data is to be exported. There are two (2) options for the types of exports. The screens for the two options are different.

- New Exports
- Previous Exports

To initiate the Export screen, select the Export option from the Import/Export drop-down on the Tool Bar.

![Action Buttons on the Export Screen](image)

**ACTION BUTTONS ON THE EXPORT SCREEN**
The action Buttons at the bottom of the export screens will provide the following functions.

**Left Side**
At the bottom of the export screen, on the left-hand side, are two (2) buttons, ‘Select All’ and ‘Clear Selection’.
The ‘Select All’ button will select all assessments displayed in the list to be included in the export file.

The ‘Clear Selection’ button will unselect all assessments previously selected.

**Right Side**

At the bottom of the export screen, on the right-hand side, are three (3) buttons, ‘Print Assessment List’, ‘Error Check’ and ‘Export’.

- If desired, select the ‘Print Assessment List’ button to print a list of assessments included in the file to be exported. Please note, when this report is generated, it does not display on the screen. The user must print it.

- Select the ‘Error Check’ button to validate and/or check for errors on all previously selected assessments. Error results display in a new screen.

- Select the ‘Export’ button to export selected assessments for submission.

**NEW EXPORT**

Complete the following steps to export an Assessment, after the Export Type of ‘New Export” has been selected from the drop-down.

1. Select the Export Path. This field is required. This is the location where the exported files will be stored.
2. Click on the Browse button to navigate to the location where the files will be exported.
3. Locate the folder and click ‘OK’.

**Please Note:** Once the Export Path is establish in jHAVEN, that path will become the DEFAULT until it is changed again.

4. Enter an ‘Export Name’.
5. Enter an ‘Export Description’ (optional).
6. Review the ‘Assessments to be Included in the Export’. Check the checkbox in front of all assessments to be included.
   a. User may use the ‘Select All’ icon, which will place check marks in all the checkboxes for all the assessment listed.
   b. User may use the ‘Clear All’ icon, to remove check marks from all the checkboxes for all of the assessments listed.
7. The user may run an ‘Error Check’ on the assessment(s).
   a. Check the checkbox in front of the assessment(s). Click the ‘Error Check’ button.
   b. The Status Report displays.
c. Select the ‘Save to File’ button to save the error report (.txt).

8. Click the ‘Export’ button to begin the export process.

**Please Note:** Any assessments that do not have checks in the checkboxes in front of the Patient Name will NOT be included in the export.

9. The files are ready for submission to the national database.

**PREVIOUS EXPORT**

Complete the following steps to export an Assessment, after the Export Type of “Previous Export” has been selected from the drop-down.

1. After selecting the ‘Export Type’ of Previous Export. Locate the ‘Export Path’. Click on the Browse button to navigate to the location where the files will be exported.
2. Enter the Export Name.
3. Select the Export Description (optional). This field can be used to document details regarding the export.
4. A list of previously exported batches available to be exported is displayed.
5. Select/highlight a ‘Previous Export’.

6. A list of assessments available to be exported is displayed. A minimum of one selection is required.

7. Review the ‘Assessments to be Included in the Export’. Check the checkbox in front of all assessments to be included.
   a. User may use the ‘Select All’ icon, which will place check marks in all the checkboxes for all the assessment listed.
   b. User may use the ‘Clear All’ icon, to remove check marks from all the checkboxes for all of the assessments listed.

8. The user may run an ‘Error Check’ on the assessment(s).
   a. Check the checkbox in front of the assessment(s). Click the ‘Error Check’ button.
   b. The Status Report displays.
   c. Select the ‘Save to File’ button to save the error report (.txt).

9. Click the ‘Export’ button to begin the export process.

10. The Export complete message displays to notify the user the process is complete.
    a. The location of the exported files displays in parenthesis at the end of the message.

**IMPORT DATA FROM OUTSIDE SOURCE**

**IMPORT RECOMMENDATION:** The application is now encrypted. The encryption within the application is federally required. You may experience some slowness while using import feature. It is strongly recommended to import assessments in small batches and should be done frequently to optimize the application at its best capacity.

The Import Assessments screen allows the user to determine how data is imported. Complete the following steps to import an assessment:

1. Select the Import option from the Import/Export drop-down on the Tool Bar.
2. The Import Assessment screen displays.

![Import Assessment Screen](image)

3. Select the Location.
   
a. Click on the Browse button to navigate to the location of the files to be imported.
   
b. Select the location from which to pull the import file.

4. If no warning message is wanted when a patient is added into jHAVEN during the import process, check the ‘Patient Data Options’ checkbox to turn off the warning message.

![Patient Data Options](image)

5. Select the options from the Miscellaneous Data Options list by checking the checkboxes in front of the desired options.
   
a. “Do not display warnings in error check results.” This selection removes warning messages from the error check results report that displays after importing data. Only fatal errors are included in
the report.

b. “Assign Exported status to assessments without errors (instead of Export Ready.)” This selection sets the status of imported assessments to Exported, if the record does not have errors.

c. “Associate assessments with a blank agency ID field to the selected agency below.” This selection provides the option to allow the system to import assessments, which have no Agency ID, by using the agency select from the drop-down below.

d. “Associate assessment with a blank M0090 date to the selected data specification version.” This selection provides the means to allow the system to import assessments, which have a blank Completion Date field, by using a valid data specification based on the date range selected from the drop-down below.

6. Click the ‘Select All Options’ button to check or uncheck all checkboxes.

7. Select the ‘Error Check’ button to validate and/or check for errors on all assessments to be imported. Error results display in a new screen.

8. Click the Import button to import selected assessments into jHAVEN.

9. An ‘Import complete’ message displays as well as a Status Report for all assessments included in the import.
10. If no files are successfully imported, the Import failed message box displays along with a Status Report.

11. Click the ‘OK’ button on the Import Complete pop-up window to view the Status Report.

12. Click on the ‘Save to File’ button, on the bottom of the report, to save a copy of the report to the computer. **Please Note: This is the ONLY time the user will have access to this status report.**

13. Click on the ‘X’ icon in the top right corner to close the report.

**JHAVEN REPORTS**

jHAVEN reports allow users to preview and print assessment information, as well as detail and summary information for both agencies and patients.

**REPORT VIEWER**

The jHAVEN application reports are generated in third-party software, Report Viewer, using this software’s **ICONS** and formatting. All the reports use this software in the same fashion.
**PRINT REPORT**
To print the report, click the Print icon on the Report Viewer screen.

**SAVE REPORT**
To save the report, click the Save icon on the Report Viewer screen.

**EXPORT REPORT**
To export a report click the arrow next to the ‘Save’ icon. The available export values display.

**AVAILABLE REPORTS**
The following reports are available in jHAVEN:

- Event Tracking
- Assessment Data Entry By Status
- Assessment Data Entry By Branch
- Data Comparison

**EVENT TRACKING REPORTS**
Event Tracking reports are available for: Assessment, Agency, Branch, User, and Patient data.

Complete the following steps to run the Event Tracking report:

1. Select Event Tracking from the Reports drop-down on the Tool Bar.

![Event Tracking Criteria Parameter Screen]

3. Select an Event from the available options in the drop-down menu.
4. Select or enter the ‘Event Dates’.
5. Select the ‘OK’ button to generate the report.
6. Select the Cancel button to close the parameter screen; no report will be generated.
7. The Report Viewer screen opens displaying the generated report.

**ASSessment DATA ENTRY – BY STATUS REPORT**

Complete the following steps to run the Assessment Data Entry – By Status report:

1. Select Assessment Data Entry – By Status from the Reports drop-down on the menu bar.

![Assessment Data Entry by Status Reports]

2. The Criteria parameter screen for ‘Assessment Data Entry – By Status’ report displays.
3. Select an Agency.
   a. “Agency drop-down. Use up and down arrows to select an Agency.*”

4. Select a Status.
   a. “Status list. Use up and down arrows to select a status.*”
   b. To select all statuses, hold the SHIFT button while you select or scroll through the list.
   c. To select a few statuses, hold the CTRL button while you select what you need.

5. Select the ‘OK’ button to generate the report.


**ASSESSMENT DATA ENTRY – BY BRANCH REPORT**

Complete the following steps to run the Event Tracking report:

1. Select the ‘Assessment Data Entry – By Branch’ report from the Reports drop-down on the Tool Bar.

2. The Criteria parameter window displays.
3. Select an Agency.
   a. “Agency drop-down. Use up and down arrows to select an Agency*”

4. Select a Branch.
   a. “Branch drop-down. Use up and down arrows to select a Branch*”

5. Select a Status.
   a. “Status list. Use up and down arrows to select a status*”
   b. To select all statuses, hold the SHIFT button while you select or scroll through the list.
   c. To select a few statuses, hold the CTRL button while you select what you need.

6. Select/enter a date range.
   a. “Data Entry Date”
   b. “From*”
   c. “To*”

7. Select the ‘OK button to generate the report.

8. The Report Viewer screen opens displaying the generated report.

**DATA COMPARISON REPORT**
Complete the following steps to run the Data Comparison report:

2. The Criteria parameter window displays.

![Image of Criteria parameter window]

3. Select an Agency.
   a. “Agency drop-down. Use up and down arrows to select an Agency*”
   b. Rules:
      i. System Administrators may select the Agency from multiple options listed in the drop-down.
      ii. Data Entry Users will have only one option; the agency with which they are associated.

4. Select/enter a required date range.
   a. “Data Entry Date”
   b. “From*”
   c. “To*”

5. Select the ‘OK’ button to generate the report.

CLOSING THE APPLICATION

SAVE RESOURCES POP-UP WINDOW
If data has been updated, and those screens have not been saved, prior to an attempt to close the application the user will see a pop-up window listing those updated screens.

Complete the following steps to save the screens with updates still not saved:

1. Select the resources to save. Each resource listed will have a checkbox in front of it. By default, all resources will be selected.
   a. To save an item, make sure the checkbox is checked.
   b. To close an item without saving it, uncheck the checkbox.
   c. To NOT save any of the items, click the ‘Deselect All’ button.

SESSION TIME OUT
To assist with keeping data secure in jHAVEN, if at any time during data entry there is no activity by the user for 15 minutes, the system will timeout and a warning will be issued. To continue with the session, the user may click OK. If the user does not click OK before the time displayed on the pop-up, the user will be logged out of jHAVEN and the login screen will be displayed.
**LOGOUT**
To log out and return to the login screen, select the Logout option from the Security drop-down on the menu bar.

![Image of menu bar with Logout option highlighted]

**EXIT**
To close jHAVEN, select the Exit option from File drop-down on the menu bar.

![Image of File menu with Exit option highlighted]

jHAVEN can also be closed by selecting the close icon in the top right corner of the screen.

**DATA BACKUP ON CLOSE**
jHAVEN creates a backup of the database when the application is closed following an active session. Complete the following steps to close and backup data.

1. Select the Exit option from the File drop-down on the menu bar.
2. The following Decision Message will display: “Would you like to close jHAVEN?”

![Image of decision message]

3. Select ‘Yes’ to continue.

4. The Backup jHAVEN Database pop-up displays the current backup location along with the following Decision Message: “Would you like to backup the database?”
5. Choose one of the following options.
   a. Click ‘Yes’ to back up the database and close jHAVEN.
   b. Click ‘No’ to close jHAVEN.

6. If ‘Yes’ is selected, the pop-up that indicates the backup is in process will be displayed. When the backup is complete this window closes automatically and the user will receive a confirmation message.

Please Note: If a backup has not occurred within the last 7 days of an active session, the jHAVEN application will automatically backup the database when closing the current session.

**CHANGING THE BACKUP FILE LOCATION**

To change the location used when the jHAVEN database is backed up, use the File Menu drop-down; select ‘Change Backup Location’.

The default location for the backup database is located in a database/backup folder where the application is installed. Only System Administrators may change the location where the backup will be stored.

Complete the following steps to change the location where the backup will be stored.

1. Select the ‘Change Backup File Location’ option from the File drop-down from the menu bar.
2. The Change Backup File Location window displays with the current backup location highlighted.
3. Select the desired backup location using the scroll bar OR create a new folder using the ‘Make New Folder’ button.
4. Click ‘OK’ button to set the location and close the screen.
5. Click the ‘Cancel’ button to close the window without changing the location of the backup files.

**RESTORE THE DATABASE FROM BACKUP**
In the event of data loss, System Administrators may perform a database restore from a prior database backup.

A database restore requires the assistance of the QIES help desk (1-877-201-4721 or help@qtso.com).

**SECURITY**
All User Roles have access to the Security Menu Bar selection. The available options are:

- Change Security Answers
- Change Password
- Logout

**CHANGE SECURITY ANSWERS**
Complete the following steps to change your answers to your security questions:

1. Click on the Change Security Answers option from the Security drop-down menu.

2. A pop-up window will be displayed, which requires the confirmation of the user’s current password.

3. Enter the password.
4. Click ‘OK’ button. Clicking the ‘Cancel’ button will end this process.
5. The ‘Security Questions’ pop-up window displays.
6. Enter at least six (6) answers AND tab forward.
7. Click ‘OK’ button.
8. The window is closed and the new answer is saved.
CHANGE PASSWORD
User passwords may be changed at any time. However, all Users will be asked to change their passwords every 60 days. Complete the following steps to change a password.

1. Select the ‘Change Password’ option from the Security drop-down on the Menu Bar.

2. The ‘Change Password’ screen displays.
3. Enter the current password in the ‘Password’ text field.
4. Enter a new password in the ‘New Password’ text field.
5. Enter the new password again in the ‘Confirm New Password’ text field.
6. Click the ‘Change Password’ button. Clicking the ‘Cancel’ button will not change the password and will end this process.
7. The pop-up window closes and the new password is saved.

LOGOUT
To log out and return to the login screen, select the Logout option from the Security drop-down on the menu bar.

HELP
Help documents are available for all data entry fields and assessment questions. While performing data entry, the help documents can be accessed by clicking on the Help icon to the right of each field/question. After clicking on the Help icon, a pop-up window will display the information describing the field.

HELP OPTION FROM MENU BAR
Help information can also be accessed by selecting Options from the Help drop-down on the Menu Bar. They are available any time a user is logged into jHAVEN. Available Options for selection are:

- Search
- Help Content
- About Quality Management System
- Home Screen
HELP CONTENTS
After selecting the ‘Help Content’ option from the Help drop-down, clicking the bold jHAVEN heading will display ALL help documents for the most current version of jHAVEN.

Expanding the ‘jHAVEN’ topic and then the ‘jHAVEN Item Help by Timeframe’, on the left, will allow the user to narrow the list down to a more specific set of items.

QTSO Help Desk
The QTSO Help Desk is available 7AM-7PM CST Monday-Friday by calling 877-201-4721 or by email to help@qtso.com.

MISCELLANEOUS SYSTEM MAINTENANCE

PASSWORDS
Passwords are case-sensitive. The following rules are displayed at the top of the Change Password screen:

- The new password and confirm new password must match.
- The new password must be at least eight (8) characters long.
- The new password must be no more than 20 characters long.
- The new password must not contain any space.
- The new password must not contain the User ID, First Name, Last Name, or Email.
- The new password must not begin with a number.
- The new password can only contain a maximum of three (3) repetitive characters.
- The new password must contain at least one for each of the following type of characters.
  - Upper-case Character: A-Z
• Lower-case Character: a-z
• Number: 0-9
• Special Character: - &~'!@#$%^*()_+={}\|:;''<>,.?/
• The new password must not match any of the user’s most recent six (6) passwords.
• The new password will be set to expire in 60 days.

FORGOTTEN PASSWORDS
Complete the following steps:

1. On the login screen, enter User ID and click the ‘Forgot Password’ button.

   ![Login Screen]

2. The ‘Security Questions’ pop-up window displays listing three (3) of the six (6) Security questions previously answered.

   ![Security Questions]

   To enable the OK button, all questions must be answered.
   What is your mother’s maiden name?  
   What is your favorite sport?  
   What city were you born in?  

   ![OK/Cancel Buttons]

3. Answer the security questions.
4. Click the ‘OK’ button to continue to the Change Password screen. Clicking the ‘Cancel’ button will halt the “Forgot Password” process and return the user to the login screen.

LOCKED ACCOUNTS
The following message will display if a user account becomes locked: “Your account has been locked. Contact your System Administrator or click Forgot Password Alt+F to unlock your account.”
The user may either:

- Follow the instructions for [Forgotten Passwords](#) to unlock the account. Security questions must be answered and a new password must be created to continue.

OR

- The System Administrator can reset the account following the steps:
  1. The System Administrator must log in.
  2. On the User screen, select the user that has a locked account (displays in bold in the User Summary section).
  3. On this User screen, check the ‘Reset Password/Unlock The Account’ checkbox.
  4. Click the Save icon.
  5. The user account is unlocked with the password reset to the User ID.

**HELP DESK TO UNLOCK ACCOUNT**

If the account cannot be unlocked contact the Help Desk for assistance. The Help Desk can utilize a secure password reset tool that allows the generic jHAVEN account (used at initial log in) to be reset for the purpose of unlocking the other accounts.

**NETWORK CLIENT/SERVER UNLOCK**

These instructions apply ONLY to the Network Client/Server configuration of the jHAVEN application.

In the Client/Server version of jHAVEN, multiple users access a central database. When this functionality is provided, it is necessary to provide additional safe guards to keep multiple users from trying to open and use the same record. The system will lock a record once a user opens it for data entry. That user’s User ID will be placed in the ‘Locked’ column in the Assessment Search Summary.

The System Administrator is the only user who can, if necessary, unlock records. They can locate the locked records using one of two methods:

- The Assessment Search Screen ‘Unlock Assessment’ button.
- The System Administrator Unlock pop-up window.
UNLOCK USING ASSESSMENT SEARCH SCREEN

On the Assessment Search Screen, the assessment records that are locked will have a User ID in the ‘Locked’ column in the summary result.

Complete the following steps to unlock one of the locked assessments:

1. Locate and highlight the desired assessment.
2. Click on the ‘Unlock Assessment’ button.
3. The Assessment will be unlocked.

Please Note: It is recommended that the System Administrator communicate with the user who has the assessment locked, if possible, before using the unlock feature.

UNLOCKING RECORDS USING THE LOCKED POP-UP WINDOW

The System Administrator also has the ‘Locked Records’ option under the Administration Menu Bar.

Complete the following steps to unlock one or more of the locked records using the Locked Records screen.

1. Click on the ‘Locked Records’ option in the drop-down.
2. The Locked Records pop-up screen displays with the following columns:
   - Record Type will contain one of the valid values: Agency, User, Patient, Branch or Assessment
   - Identifier will contain the information required to identify the specific record.
   - User Id is that of the user who has locked the record.
   - Lock Date is the date that user locked the record.

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Identifier</th>
<th>Locked By</th>
<th>Lock Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Patient</td>
<td>Patient Last Name, First Name</td>
<td>SysAdmin01</td>
<td>09/02/2014 11:10</td>
</tr>
<tr>
<td>Agency</td>
<td>HHA01-Client - HHA01Client01(1A)</td>
<td>SysAdmin01</td>
<td>09/02/2014 11:10</td>
</tr>
<tr>
<td>Branch</td>
<td>16Q2345001 - 1A</td>
<td>SysAdmin01</td>
<td>09/02/2014 11:10</td>
</tr>
<tr>
<td>User</td>
<td>SysAdmin01</td>
<td>SysAdmin01</td>
<td>09/02/2014 11:10</td>
</tr>
</tbody>
</table>

3. Locate the record(s) that require unlocking.

4. Check the checkboxes for each record to unlock.

OR

5. If all records listed must be unlocked, click on the ‘Select All’ button.

6. Click the ‘Unlock’ button.

7. The “Record(s) Unlocked” message displays. “<<Number>> record(s) have been unlocked.”